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Microsoft Office 2003 Introduction

Welcome to Microsoft Office Outlook® 2003, part of Microsoft Office 2003 Editions—the easiest way to help more people use information to make a positive impact on business. The Office 2003 Editions offer new technologies and features while improving upon existing and familiar tools to facilitate effective and efficient collaboration and information sharing.

This document delivers an overview of Office 2003 Editions, including how they can help you connect people and information as well as get valuable online Help services. We take a close look at Outlook 2003 in action, providing guidance on the specific details of this integral part of Office 2003 Editions.

Through integration with Microsoft Windows® SharePoint® Services, the Office 2003 Editions offer advances in intranet collaboration to help users gain access to and share information both internally and externally. Support for Information Rights Management (IRM) and industry-standard Extensible Markup Language (XML) provides a platform on which to build cost-effective solutions that can have an immediate, positive impact. In addition, the Office 2003 Editions offer new ways to organize and manage e-mail and make more use out of the workday. 

Design Goals

With a focus on connecting people, information, and business processes, the design goals integrate collaboration, usability, and information management.

Connect people

Designed to integrate with intranet technologies such as Microsoft Windows SharePoint Services, the Office 2003 Editions provide new ways to connect individuals, teams, and organizations. By incorporating the new tools with familiar Microsoft Office menus, functions, and interfaces, training and implementation time is minimized. Workers can collaborate from any location by using shared information and review processes that include the following features: 

· New! Shared Workspace task pane facilitates efficient collaboration and document sharing.

· New! Shared Attachment option offers an automatic way of creating document workspaces through e-mail messages, when sending attachments for review. Document workspaces provide a forum for managing projects, including collaborative review –with features such as automatic updates to the most current version and the ability to share documents and other relevant information in real time.

· New! Meeting Workspace option automatically creates workspaces through Outlook invitations. Meeting Workspaces help enhance the productivity of meetings by providing a place to coordinate schedules, disseminate materials, and store notes and minutes.

· New! Instant messaging (IM) and Alerts technology is integrated throughout the Office 2003 Editions collaboration tools, providing instant information and the ability to initiate IM conversations quickly while working within text documents, shared workspaces, or Microsoft Office Outlook 2003. 

· Improved! Contacts and Calendars can be shared easily among team members and viewed side by side to facilitate meeting coordination and scheduling. 

· New! Information Rights Management (IRM) functionality protects sensitive information from unauthorized distribution or alteration, and allows companies to set and enforce policies that help control how their data is used.

· New! Office Word 2003 Formatting and Editing Restrictions maintain formatting structure and document integrity.

Connect information

The Office 2003 Editions are designed to make it easier for people to manage an ever-increasing volume of business information. Improvements and new features in Outlook 2003 enable users to organize and prioritize e-mail messages quickly and easily, and new security settings offer increased support for junk e-mail filtering. Support for remote and mobile workers includes improvements to connectivity performance, such as better caching, and shared calendars. Obtaining information from a variety of locations is made easier with organizational tools, such as the Research task pane. The following are new and improved features for connecting information:

· New! Mail View, Reading and Navigation panes in Outlook 2003 work together to give users a more comprehensive, organized view of their e-mail messages, with more efficient use of screen space.

· New! Outlook 2003 Search Folders provide an easy, automated way to organize e-mail messages without physically moving them. Users can create customized Search Folders based on their business needs.

· New! Outlook 2003 Quick Flags provide one-click marking of e-mail messages that require action.

· Improved! Remote and Mobile Access includes improved Outlook 2003 connectivity and better caching.

· Improved! Enhanced Rules and Alerts provide automated organization of incoming e-mail messages, in addition to automatic notifications so that users can stay current with incoming e-mail messages without spending extra time doing so. Alerts can also be integrated with document workspaces to notify users about important project developments.

· Improved! Research task pane accesses needed information more efficiently. 
· Improved! E-mail Security enhancements help stop incoming messages that contain viruses, improve junk e-mail filtering, and block unsolicited attachments from communicating back to the originating servers.

· Improved! Enhanced Ink support provides a better experience overall when using Tablet PCs, offering support for handwritten e-mail messages and the ability to write directly in Word 2003, Microsoft Office PowerPoint® 2003, and Microsoft Office Excel 2003 documents.
Connect business processes

Often, critical business information is kept separate from the programs that workers know 

and use. With its extensive support for industry-standard XML, the Office 2003 Editions help bring business processes and information together on the desktop. To facilitate greater efficiency, features such as Smart Documents and Programmable task panes help users share customizable, task-specific information easily. New and improved tools for connecting business processes include the following features: 

· New! Smart Documents bring relevant information directly to the task at hand through a new Programmable task pane user interface. With Smart Documents, XML solutions can be created to enable business processes, help users complete forms and other documents, and then link that information to back-end systems that support XML. As the user clicks through the document, the program is modified to present the appropriate functions to complete the task.

· New! Extensible Smart Tag support is now offered in all of the Office programs, including PowerPoint 2003, Outlook 2003, and Access 2003. Support includes automatic configuration capabilities such as formatting and populating an index at the end of an article.

System Recommendations

Here are the system requirements for the Office 2003 Editions:

· Personal computer with an Intel Pentium 233-megahertz (MHz) or faster processor (Pentium III recommended)

· Microsoft Windows® 2000 with Service Pack 3 (SP3) or later; or Windows XP or later

· Super VGA (800 × 600) or a higher-resolution monitor

· 128 megabytes (MB) of RAM or more 

Hard disk usage will vary depending on configuration; custom installation choices may require more or less hard disk space. The following are the hard disk requirements for individual Office 2003 Editions.

Microsoft Office Professional Edition 2003 

· 400 MB of available hard disk space; 190 MB of hard disk space for Microsoft Office Outlook 2003 with Business Contact Manager 

· Optional installation files cache (recommended) requires an additional 290 MB of available hard disk space 

Microsoft Office Small Business Edition 2003 

· 380 MB of available hard disk space; 190 MB of additional hard disk space to use the optional installation of Outlook 2003 with Business Contact Manager 

· Optional installation files cache (recommended) requires an additional 280 MB of available hard disk space 

Microsoft Office Standard Edition 2003 

· 260 MB of available hard disk space 

· Optional installation files cache (recommended) requires an additional 250 MB of available hard disk space 

Microsoft Office Student and Teacher Edition 2003 

· 260 MB of available hard disk space 

· Optional installation files cache (recommended) requires an additional 250 MB of available hard disk space

Additional items or services

Some features or advanced functionality have additional requirements.

Microsoft Office Professional Edition 2003

To use the optional installation of Outlook 2003 with Business Contact Manager, you need to meet the following system requirements:

· A PC with a Pentium 450-MHz or faster processor 

· 260 MB of RAM or more recommended 

· 190 MB of additional hard disk space 

· For speech recognition: 

· Pentium II 400-MHz or faster processor 

Close-talk microphone and audio-output device 

· Microsoft Exchange Server is required for certain advanced functionality in Outlook 2003

· Microsoft Windows Server™ 2003 running Windows SharePoint Services is required for certain advanced collaboration functionality 

Internet functionality requires dial-up or broadband Internet access provided separately; local or long-distance charges may apply 

· Specific inking features require running Microsoft Office XP Pack for Tablet PC (Tablet Pack) on the Tablet PC.

Information Rights Management features require access to a Microsoft Windows 2003 Server running Windows Rights Management Services (RMS) for Windows Server™ 2003.

Note: Business Contact Manager will be disabled in the presence of an Exchange-technologies-based e-mail system.

Microsoft Office Small Business Edition 2003

To use the optional installation of Outlook 2003 with Business Contact Manager, you need to meet the following system requirements: 

· A PC with a Pentium 450-MHz or faster processor 

· 260 MB of RAM or more recommended 

· 190 MB of additional hard disk space 

· For speech recognition: 

· Pentium II 400-MHz or higher processor 

· Close-talk microphone and audio output device 

· Exchange is required for certain advanced functionality in Outlook 2003 

Note: Business Contact Manager will be disabled in the presence of an Exchange-technologies-based e-mail system. 

· Windows Server 2003 running Windows SharePoint Services is required for certain advanced collaboration functionality 

· Internet functionality requires dial-up or broadband Internet access provided separately; local or long-distance charges may apply

Office Standard Edition 2003

· For speech recognition: 

· Pentium II 400-MHz or faster processor 

· Close-talk microphone and audio-output device 

· Microsoft Exchange Server is required for certain advanced functionality in Outlook 2003 

· Microsoft Windows Server 2003 running Windows SharePoint Services is required for certain advanced collaboration functionality 

· Internet functionality requires dial-up or broadband Internet access provided separately; local or long-distance charges may apply 

· Specific inking features require running Microsoft Office XP Pack for Tablet PC (Tablet Pack) on the Tablet PC.

This section examined the design goals, system recommendations, and additional services of Office 2003 Editions. The next two sections take a deeper look at Office 2003 Editions and how they facilitate connecting people and connecting information, focusing on Outlook 2003.

Introduction 

Every employee faces challenges when a project requires team collaboration. The Microsoft Office 2003 Editions and the integration with Microsoft Windows SharePoint Services (WSS) provides a platform that includes programs employees use daily to work with team members in a centralized location, making the team’s work more effective and efficient.

The Office 2003 Editions allow for closer teamwork experience. New task panes from within the documents and e-mail messages provide information about other team members and also offer access to resources. Team members can use Instant Messenger (IM) integration to see when other team members are online or offline. New calendar features in Microsoft Outlook 2003 make scheduling meetings with other team members quicker and more effective. Office 2003 Editions also offer content protection rights to authors, ensuring they have complete access to and control over their documents.

Windows SharePoint Services Integration with Office 2003 Editions Programs

The integration of Office 2003 Editions programs and WSS offers users tools that are powerful, easy to use, and make collaboration easier. A WSS site provides a virtual community for team collaboration—making it easy for users to work together on documents, projects, events, and other activities where information sharing is essential.

In addition to the new workspaces, Outlook 2003 offers a workgroup server, offline availability, and multiple calendar views and lists. Microsoft Office Access 2003 has features that allow users to link tables to other SharePoint Web sites and preserve full read/write capabilities. Because Excel 2003 and the various SharePoint lists are integrated more closely, a user can import or export a list to or from Excel and share it with other team members. The Office 2003 Editions program and WSS integration gives users more opportunities for increased accessibility to view, edit, read, or write information within Outlook, Access, and Excel.

Windows SharePoint Services and Outlook 2003

With Office 2003 Editions, data from WSS can be used from directly within Outlook, allowing users to make better use of team information by integrating it with their own. Outlook 2003 provides users with team calendars to centralize team-specific appointments. It also provides specialized alerts to notify team members about any changes made to shared documents, and other benefits, such as workgroup servers, offline availability, and SharePoint capabilities.

Team calendars

Team calendars allow teams to post their schedules of product reviews on a SharePoint site for the whole team to reference. Team members can check that schedule against their own by opening up the live calendar view of a SharePoint list side by side with their individual Outlook calendars. Events from a SharePoint list look and act just like Outlook appointments and can be dragged and dropped from the SharePoint calendar into each user’s Outlook calendar.

Specialized alerts

Specialized alerts can help workers be more effective by providing relevant information that keeps them up to date. Users can view alerts by clicking Alert Me links in any SharePoint Web site, or by selecting Rules and Alerts from the Tools menu in Outlook, and then clicking the Manage Alerts tab.

Alerts can be used to notify users of changes to documents, list items, document libraries, lists, surveys, or even search results by sending e-mail notifications. In addition, users can easily set up rules to move alert e-mail messages to folders and can view all active alerts in Outlook by using the Rules and Alerts dialog box. From there, users can delete the alert, jump directly to the Web site, create rules to act on the alerts, and more.
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By selecting the options that best meet their needs, users can customize the alerts they receive and stay up to date on the status of a shared document.

Other benefits

Other benefits of tight integration between WSS and Outlook 2003 include:

· Workgroup server. Small businesses can use WSS as a small workgroup server that enables shared contacts and calendars without having an Exchange Server.

· Offline availability. Data from WSS is cached on the local computer so that it can be taken offline. These calendar and contact lists can be viewed even when the SharePoint site is unavailable, such as when the user is on an airplane.

· SharePoint in Outlook 2003. Outlook users can open calendar lists, event lists, and contact lists within the Outlook user interface as a read-only source of data. The data from WSS looks and acts just like native Outlook calendars and contact lists; and calendars can be opened side by side.

Shared lists

Users of WSS benefit from the enhanced ability of Office 2003 Editions to work with SharePoint lists. Each enhancement to the list experience in WSS enables a range of scenarios not previously available. The enhancements also provide the ability to combine SharePoint lists with the rich functionality of core Office programs, opening new possibilities for collaboration, data collection, and analysis. 

· New! Grid view. This new view style is similar to the grid display style in Excel 2003 and brings Excel-like functionality to WSS with functions such as Calculation Formulas, AutoFill, AutoComplete, Sorting, and Filtering.

· New! Multiple-user list collaboration. Multiple users can now edit the same list at the same time. If WSS detects any conflicts, it presents conflict-resolution options.

· Improved! Easy editing. Users can drag and drop to rearrange rows and columns or move data inside a list.

· Improved! Office program integration. Users can now have the best of both worlds, using Office programs to work with SharePoint lists. 

· New lists. New lists include Photo Library, which offers options for storing and viewing pictures, and Business Document Libraries, which enable XML solution authoring, editing, and storage in the team site.

· Improved lists. Improvements to the existing lists include options for scheduling re-occurring meetings in event lists, and new security settings that allow delegation of permissions to a peer-list level.

The following table shows WSS integration features for each program in Office 2003 Editions.

	Windows SharePoint Site Feature
	

	Open and Save from File menu
	Excel, Outlook, PowerPoint, Publisher, Word

	Create shared attachment
	Outlook

	Synchronize calendar and contact list sites
	Outlook


Manage team’s time

One of the ways to make a project successful is to ensure that all team members stay current with personal and team schedules. The Office 2003 programs and WSS integration offer users instant messaging capabilities while working within Outlook 2003 or with a document. Team members can also view personal and team calendars and contacts side by side, so scheduling meetings and tracking down references is more efficient.

Instant messaging integration and presence integration

Instant messaging (IM) technology is integrated with Office 2003 programs to provide instantaneous presence information and the ability to initiate conversations quickly from within documents or Outlook.

Team calendar views

When a user is viewing multiple calendars, correlations between appointments can be difficult to understand. Outlook 2003 offers color-coded team appointments within each team member’s calendar so that the user can distinguish between team appointments and other appointments.

Access the side-by-side calendars in Outlook 2003

Outlook® 2003 makes it possible to view multiple calendars—including local calendars, public-folder calendars, other users’ calendars, and calendar views—side by side in the Outlook window. The color-coded calendars scroll together, making them useful for comparing schedules or finding a teammate. Users can drag appointments between calendars or onto their own calendar, or use the New Meeting With feature to set up a meeting quickly with the owners of some or all of the open calendars.

After a user has opened a calendar, it appears in the Calendar module of the Navigation pane. To turn these calendars on side by side, the user selects the box next to the appropriate calendars. To turn a calendar off, the user clears the box.
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The side-by-side calendars view in Outlook. On the left, the Navigation pane shows the calendars that the user has access to. To use the New Meeting With function, open several calendars side by side. Right-click the calendar and highlight New Meeting With.
Access integrated contacts and calendar information from Windows SharePoint Services in Outlook

Contacts and Calendars are common lists that store both personal and group information. Outlook 2003 and WSS now allow users to view team and personal calendars side by side. The user can select to view the team’s calendar and contacts directly in Outlook, making the information always available. 
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To view a calendar list from WSS in Outlook, navigate to that calendar by using the Web browser. Click Link to Calendar in the toolbar. Outlook will ask you to confirm that you want to add the calendar; click Yes.

After a calendar from WSS has been added, it can be opened in Outlook 2003 and compared with the user’s default calendar that appears in Outlook.

[image: image4.png]Calendar - Microsoft Outlook

le Edt Vew Go Took Actions Hel

wezm b
smoTwTEs

i
234E6 18
9101112131415
161718192021 22
23242526272829
30

My Calendars

[ Project Schedule:
Other Calendars

[ AlexHankin

O chris Gray

[ ave Natsuhara
O 3ane clayton

[ Sandra Martinez
[ Vadim Sazanavich

Open a shared Calendar
Share fy Calendar,

bo—

Calendar

5| contacts

[ work wesk [Fweek jvonth | SoFid | (4 Tvpe o contoct tofind

Calendar

Wednesday, June 05

Type a question for help

[ orcon g e Fr schentre wara

Wrking nch abat Ftre plans (Cafe 16
Ig 3 plans (Cafe 1)

2 Evecutive Review of April Project (Executive Boardroom 3) )

2 Workou (s )

A oers e up o date,_ ] Connected -





If you are opening a calendar, the calendar list is opened up side by side with your default calendar and added to the Other Calendars list. Contacts lists can be viewed in Outlook in the same way. 

Help Protect Sensitive Documents

New technologies in Microsoft Office 2003 Editions help protect digital intellectual property. Information Rights Management (IRM) in Office 2003 Professional allows functions such as cut, copy, paste, print, and e-mail forwarding to be restricted for specific documents and e-mail messages, giving users and organizations more control over their valuable information assets. 

Information Rights Management in Office 2003 Editions

Information Rights Management (IRM) is a new policy-enforcement technology in Office 2003 Editions that helps protect documents and e-mail messages from unauthorized access and use. IRM is a persistent, file-level protection technology that allows the owner to specify who can access a document or e-mail message and control whether those users are allowed to edit, copy, forward, or print the contents. IRM is an extension of Windows Rights Management Services (RMS) into Microsoft Office 2003 programs. IRM in Office Professional Edition 2003 requires RMS on Windows Server 2003, either within the organization or through a service such as Microsoft Passport. Windows Rights Management Services for Windows Server 2003 is a new premium service that requires a separate Client Access License (CAL).

IRM is a policy-enforcement technology, not a security technology, which allows documents and e-mail messages to be distributed while helping maintain control over who can access content and how they can use it. Once a document or e-mail message is protected with this technology, the access and usage restrictions are enforced no matter where the file or message goes. 

IRM support in Microsoft Office 2003 Editions helps corporations and knowledge workers address two fundamental needs. It: 

· Helps protect digital intellectual property. Most corporations today rely on firewalls, login security, and other network technologies to protect their digital intellectual property. The fundamental limitation of these technologies is that, after legitimate users have access to the information, the information can be intentionally or accidentally shared with unauthorized people, creating a potential breach in security policies. IRM helps protect the information itself from unauthorized access and reuse.

· Helps ensure information privacy, control, and integrity. Knowledge-capital workers often deal with confidential or sensitive information, relying on the discretion of others to keep sensitive materials in-house. IRM helps eliminate the risk of accidental leaks by disabling the forward, paste, or print functions in IRM-protected documents and e-mail messages. In addition, IRM can enforce expiration dates to help ensure that knowledge-capital workers see and use up-to-date content only.

For IT managers, IRM helps enforce enterprise policies regarding document confidentiality, workflow, and e-mail retention. For CEOs and security officers, it helps reduce the risk of having key company information get into the hands of the wrong people, whether due to accident, thoughtlessness, or malicious intent. 

When enabled by the organization, users of Office 2003 Editions will be able to take advantage of this technology easily. To create and protect documents and e-mail messages with IRM, Microsoft Office Professional Edition 2003 or the full stand-alone products are required. A simple user interface based on customizable “rights templates” available in the standard toolbar makes IRM convenient and easy to use. Other Microsoft Office 2003 Editions will give users the ability to read and edit IRM-protected content but not create it. Integration with Active Directory® provides a level of convenience not seen on today’s document-specific passwords. 

Finally, IRM-protected documents and e-mail can be shared across organizations and with users that do not have Office 2003 Editions. Microsoft is offering, for a limited time, an IRM service for customers who do not host their own Windows Rights Management 

Services server. The Rights Management Add-On for Internet Explorer allows Microsoft Windows users to consume IRM-protected documents whether or not they have Office 2003 Editions. This service will use Microsoft Passport, instead of Active Directory, as the authentication mechanism. Users of this service will not be able to create custom rights templates, such as a company’s confidential template, but they will be able to share and access IRM-protected documents and e-mail messages.

How and when to enable IRM in Outlook 2003

IRM in Outlook 2003 helps prevent unauthorized forwarding, copying, or printing of sensitive e-mail messages. It also helps protect messages that are automatically encrypted during transit, and when the sender applies usage restrictions, Outlook 2003 disables the necessary commands. Office documents that are attached to protected messages are automatically protected as well and these policies persist with the document.
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Users can apply usage restrictions to limit who can read and change e-mail messages and attachments.

Permission options 

If a protected document is forwarded to an unauthorized recipient, the document cannot be opened and an error message that contains the document owner’s e-mail appears so that the recipient can request additional rights. If the document owner decides not to include an e-mail address, unauthorized recipients get an error message. 

Organizational policies and template options

On the Windows Rights Management Server, organizations can create “rights templates” that will appear in Office Professional Edition 2003 programs. For example, a company might define a template called Company Confidential, which specifies that a document or e-mail message in that template can only be opened by users inside the company domain. These templates can reflect the policies of the organization, and the number of templates that can be created is unlimited.

Rights Management Add-On for Internet Explorer

Because enforcement of rights is done at the application level, Office files protected with IRM technology can only be opened and edited by Office 2003 Editions. However, Rights Management Add-On for Internet Explorer allows users without Office 2003 Editions to read IRM-protected materials. The Rights Management Add-On for Internet Explorer is available for download free of charge at www.microsoft.com (connect-time charges may apply).

The Rights Management Add-On for Internet Explorer will play an important role in communication between business units and with business partners, as companies may choose to migrate to Office 2003 Editions on their own timeframes. Companies can use IRM in Office 2003 Editions knowing that authorized users will be able to access and consume protected content even if they do not have Office 2003 Editions.

Additional server requirements

Microsoft Windows Server 2003 with Rights Management Services and Active Directory are required to enable IRM fully in Office Professional Edition 2003. The Rights Management Services feature requires a premium Client Access License (CAL). Microsoft is also hosting, for a limited time, an IRM service through Passport for customers who do not have Windows Server 2003. This service will enable users to share protected documents and e-mail by using Microsoft Passport as the authentication mechanism.

Note that users of Office Standard Edition 2003, Office Small Business Edition 2003, and Office Student and Teacher Edition 2003 cannot create new IRM-protected documents or e-mail messages, or modify the permissions on existing IRM-protected files. However, they can open, edit, save, and print IRM-protected documents and e-mail messages with the appropriate permissions.

Regional permissions

When teams collaborate on very large documents, some users may be assigned certain portions of the document to work on at any given time. In the past, there was no way to ensure that each user only modified the assigned portion of the document. When it came time to reconcile the edits and merge changes into a master document, large numbers of conflicting edits often caused problems.

Document owners can set permissions to protect certain regions or specific portions of a document from being edited by some or all users. Using the Protect Document task pane (by selecting the Tools menu, and then Protect Document), a document owner can first protect the whole document against any edits (optionally allowing only comments) and then assign permissions to individual portions of the document by selecting them and specifying the users who should be able to edit that selected region. Later, when reconciling the changes of different individuals, the document owner is assured that no two people edited the same area, and no conflicts exist.
After the permissions have been set up, the task pane switches focus from helping the creator set up the permissions and managing the list of users to helping users find the parts of a document that they can edit. 
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User view of the Protect Document task panel. 

Summary

The Office 2003 Editions and WSS integration make it easier and more efficient for users to connect with other team members and the information they need. By enhancing the desktop programs that employees are already familiar with, the Office 2003 Editions help users spend their time making progress on their projects instead of learning a new set of features and commands. The Professional version of Office 2003 Editions also allows authors to create documents and e-mail messages that are better protected from unauthorized use by offering IRM technology. This improved functionality in the Office 2003 Editions assists users when working on projects that require team efforts.

Introduction

Often, too much information exists in too many places for workers to keep track of it. Tasks such as organizing and managing e-mail can take much of the workday; the process of accessing e-mail slows the process further for remote and mobile users. Junk e-mail has become increasingly problematic because it can consume valuable space and prevents efficient processing of important messages.

Given this influx of e-mail and other data, locating information often requires going to multiple locations. Microsoft Office 2003 Editions provide new ways to help workers stay organized and manage the details that accompany information overload.

Organizational and design enhancements

The redesigned look and feel of the Office 2003 Editions help users manage and prioritize large volumes of information. The simplified interface of Microsoft Office Outlook 2003, Ink support for the Microsoft Tablet PC, and more make it easier to read, organize, and work with information. Some new design enhancements to Outlook 2003 include allowing users to read e-mail more quickly by using the new Reading task pane, to find important messages by using Search Folders, and to view tasks at-a-glance by using Quick Flags. 

New feature highlights

With the improvements and new features of Outlook 2003, users can manage large volumes of information quickly and easily. The new screen layout optimizes screen space while giving users a comprehensive look at their Inbox, and users can organize messages virtually in Search Folders—by using the built-in Search Folders or creating their own. Quick Flags let users mark e-mail messages that require follow-up action, and these messages are easily found in the new For Follow Up search folder. 

New security settings offer increased support for junk e-mail filtering and blocking of external content. Remote and mobile users can take advantage of improvements to connectivity performance with better caching. Along with a new look, Office 2003 Editions enables users to draw information from a variety of locations quickly by using the Research task pane.

A new look for Outlook 2003

Microsoft Office Outlook 2003 provides innovative features that help users manage and organize e-mail messages, contacts, calendar tasks, notes, and other critical information. The new look for Outlook 2003 helps users organize information to increase productivity and get the information they need. Outlook 2003 also helps users block the information they don’t need and protect against the misuse and unwanted distribution of key company information. 

Working with new e-mail views

Studies of Outlook users show overwhelmingly that the sender’s name or address is the most important criteria for consideration when deciding whether to open e-mail messages. The Multi-Line view puts the sender’s name in dark text in the upper-left corner, making it easy to scan down the list for important names. Secondary information is rendered in lighter shades of text to draw the eye toward the more important information. This Multi-Line view also provides a taller region, which makes messages easier to select with the pen on a Tablet PC.

Microsoft has taken into account how customers interact with their e-mail. In the Office 2003 Editions, Outlook 2003 features a new interface that breaks from the traditional mold. 

The new interface uses the Reading task pane (described below) to create an efficient and easy-to-use layout of messages on the screen. The vertical-column orientation of the new layout makes it possible to see nearly twice as much data on the screen at once. The new e-mail view is also optimized to help users easily find items and navigate through e-mail. This efficient layout means less time spent scrolling and more time accomplishing work.

Reading task pane

The Reading task pane helps reduce eyestrain and makes time spent reading e-mail more efficient by showing more of the message on the screen. This reduces scrolling and often eliminates the need to open and manage many separate windows for different messages.

Replacing the Preview task pane from previous versions of Outlook, the vertical layout of the Reading task pane presents messages in a manner that is more consistent with the way newspapers have been formatting text for hundreds of years. This simple redesign, in addition to the new multi-line mail list, frees up nearly twice as much monitor space for text as the previous horizontal view Preview task pane and makes for a more comfortable reading experience overall.
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The Reading task pane is on by default in Outlook 2003. The Reading task pane accommodates more than three paragraphs of text and 14 e-mail messages, whereas the Preview task pane in earlier versions of Outlook showed only two paragraphs of text and 11 e-mail messages.
Intelligent grouping

When creating lists, users naturally group similar items together, such as a to-do list under the headings “Today,” “Tomorrow,” and “Next Week.” The new e-mail view automatically applies intelligent groupings to help users sort messages. 

For example, when users arrange mail by the date it was received, Outlook 2003 splits the communications into simple groups—“Today,” “Yesterday,” “Last Week,” “Last Month,” and so on. When users rearrange by size, Outlook 2003 again splits the communications into user-friendly groups—“Large,” “Small,” “Very Large,” and so on. These groups make it easier for users to scan through a list and find what they need because the groupings reflect the way most humans work. 

Advanced users can treat these groups as objects, choosing to move, delete, copy, forward, or perform other actions on all items in the group at the same time. For example, e-mail messages could be grouped by date, and then all messages from “Last Month” could be dragged to another folder and filed away with one click.
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Clicking Arrange By shows the list of possible arrangements, such as by Date, From, Subject, Size, Flag, and so on. This menu is also available by clicking View -> Arrange By.

Smart Dates

To use space more efficiently in the Multi-Line view, Smart Dates change the date format on the fly based on how long ago the message was received. For example, an e-mail message that was received today will only display a time: 3:40 p.m. Messages that were received during the current week display a day of the week and time: Wed 1:24 a.m. For e-mail that was received many months ago, the exact time is less important, so Outlook 2003 displays only the date: 1/12/2003. This makes it easier for the user to sort, find, file, and manage e-mail quickly and efficiently.

Arrange by Conversation

Arrange by Conversation helps with the most common task that is performed in Outlook: reading mail. It was designed to help users quickly catch up on their e-mail, without embarrassing themselves by replying to items that have already been resolved. 

Arrange by Conversation displays e-mail messages in a conversation-oriented or “threaded” view, by default showing only e-mail that is unread or marked for follow-up, so the user doesn’t need to skip over dozens of read messages to find the new ones. Similar messages are grouped together, and indentation indicates clearly who responded to whom throughout the conversation. 

Each conversation can be expanded to show all related messages, so users can easily view the entire conversation at once, instead of reading pieces here and there. Users can use Arrange by Conversation as easily as they can sort mail, using the same interface, which means that the feature can be used right away by anyone who is familiar with Outlook. And, because multiple messages in a conversation share the same subject, the subject line only needs to be shown on the screen once per conversation, allowing for as many as twice the number of messages to fit on the screen. As with any group in Outlook, the conversation can be treated as an object, meaning that users can delete, copy, file, or forward the entire conversation at once.
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In the Arranged by Conversation view, messages about the same conversation are grouped together and indentation shows who replied to whom. Only unread and Quick Flagged messages are shown by default, so the screen remains uncluttered while the user catches up on e-mail.

To arrange new messages by conversation, click Arranged By over the new mail view, and then click Conversation. Or, click Arrange By on the View menu, and then click Conversation. 

Navigation pane

The Navigation pane builds more efficiency into Outlook 2003 by combining the main navigation and sharing aspects of the program into one easy-to-use pane. With the Navigation pane, users experience more relevant and context-sensitive navigation through Outlook 2003, rather than a simple, static list of folders.

In Calendar, for example, users see the date navigator and other users’ shared calendars. In Contacts, users get a list of all contacts folders they can open, both local and shared, in addition to different ways to view the contacts. The Navigation pane is on by default. To turn it off and on, click View, and then click Navigation pane.

The Navigation pane improves Outlook 2003 in several ways:

· Efficient use of screen space. The best of the Outlook bar and the Folder list are brought together into a smaller, more efficient space. All navigation options, not just folder navigation, are in one place, giving users dramatically increased space to view their data. For example, users can view up to twice as much of their Calendar in Outlook 2003 compared to Outlook 2002.

· Context sensitivity. Simplified, context-sensitive navigation shows the most relevant information for each type area of Outlook. For instance, in the Mail pane, users view the list of e-mail folders and search folders. In Calendar, they see a date picker and a list of calendars that are available to them.

· Shared data. Sharing information is simplified by presenting shared data next to a user’s own data. For example, users can view other calendars to which they have access, placing them side by side with their own calendar.

· View settings. View settings appear in the Navigation pane, making it easy to change how something is displayed.

· Quick Launch. Advanced users appreciate the ability to shrink the module into a Quick Launch bar to save space.

· Go menu. The Go menu and associated keyboard shortcuts make the Navigation pane more accessible.

[image: image10.png]Favorke Foldrs
Ctboc
5 uvead i

&1 For Follow up[ Ui}

3 5ene ems

Al il Foders

Y T —
) Deleted Items
(Aorshs
Stnboc

CornkEmi g

28 Catendar
8] Contacts

Tasks

] reres
T2 roldertiot

o





[image: image11.png]Favorte Folders

B

8 uwesdval

B rorroton o I8

3 5ent ems

Al il Foders

23 €6 abox - chris Gray
@ Deleted Items
(Aorshs
E Irbox

ok Emed
(5 oubox
(53 5ok tems
2 5 earch Fodars
3 For Follow Up [4]
| targe i
3 vead i

T




Navigation pane with large buttons
Navigation pane with smaller buttons

The Navigation pane. The splitter between the big buttons at the bottom and the content pane can be moved up and down to create larger or smaller buttons. The large buttons are great for easy clicking with Tablet PC or other pen-based computers, or users may choose to shrink all the buttons to a single Quick Launch bar in order to save space.

Navigation pane modules

Each of the eight Navigation pane modules has a unique but consistent user interface that presents the most relevant information in an efficient space. The following eight Navigation pane modules are available.

Mail view

The Mail pane displays e-mail folders and Search Folders, and also includes a Favorite Folders section at the top for quick access. To create favorites, users drag an e-mail folder or Search Folder to the Favorite Folders area.
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The Navigation pane in Mail view. By default, four large buttons appear at the bottom, with three buttons minimized to the Quick Launch state. The section at the top, Favorite Folders, can include any folders that you want to keep handy for quick reference—just drag them to the Favorites section.

Calendar view

The Calendar pane shows the date navigator at the top and under that the list of all calendars to which the user has access, including local calendars, Microsoft Windows SharePoint Services calendars, public folder calendars, and other users’ calendars—all in one simple list. Calendars can be individually turned on or off to view them side by side in the Outlook window. Links are also available to open shared calendars and to share the user’s own calendar (or modify permissions).
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Through the Calendar view, all local, shared, and team calendars are simplified to a single list, regardless of location. 

Contacts view

Like the Calendar pane, the Contacts pane displays all contacts to which the user has access—including local contacts, Windows SharePoint Services contacts, public folder contacts, and other users’ contacts. Users can opt to view contacts in different ways, such as By Company or Address Cards, in addition to any custom views they have created. Links are also available to open shared contacts, share contact information, modify permissions, or modify the options of the Current View.
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In the Contacts view, all contacts folders that the user can open, including local, public, and shared, are presented in a simple list. The Current View section provides an easy way for users to arrange contacts.

Tasks view

The Tasks pane shows a list of all tasks folders that the user can open, including local tasks, public folder tasks, and other users’ tasks. The viewing options for Tasks include built-in views such as Overdue Tasks and Next Seven Days, in addition to any views that a user has created. Users can also select links that open shared tasks, share task information, modify permissions, or modify the options of the Current View.
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In the Tasks view, all tasks folders that the user can open, including local, public, and shared, are presented in a simple list. The Current View section provides an easy way for users to organize their tasks into logical groups.

Notes view

The Notes pane shows a list of the user’s notes, including shared notes. Viewing options for Notes include built-in views such as By Category and Last Seven Days, in addition to any views a user has created. Links are also available to open shared notes, share the user’s own notes, modify permissions, or modify the options of the Current View.

Folder list

The Folder list is designed to help with data-file management activities such as archiving and copying between mailboxes. All local folders of all types are shown in the Folder list, just like the Folder list in previous versions of Outlook. Convenient links are available to help manage folder sizes and Outlook Data Files.

Shortcuts

The Shortcuts pane is a location for shortcuts to nearly anything: Outlook folders, programs, documents on the hard drive, files on a network, shared folders, Web pages, and more. The user can create groups to organize these shortcuts and can collapse and expand these groups to use the space more efficiently. To add a shortcut, users can employ the provided link or just drag and drop items onto the list.

Journal

The Journal pane shows a list of all Journal folders that are available to the user, including public and shared Journal folders. As with the Contacts, Tasks, and Notes panes, all available Journal views are shown in this pane and can be customized. Links to share or open shared Journal data are also provided. The Journal pane is off by default, but users can turn it on by using the Navigation pane Options menu or by selecting Journal from the Go menu to use it without adding it to the Navigation pane.

Note: Each Outlook pane displays six options. By using the Navigation pane Options menu, users can show, hide, or rearrange the panes.

Go menu

The Go menu is back! The Go menu makes it easy to navigate through Outlook 2003 by using the keyboard. Users can also change their view of the Navigation pane by using the Go menu.

[image: image16.png]Ble Edt Vew

Tools _Actions el
wal i1

@

Ditew - | 4

Colendsr Cikz

Favorie Folders g G
Tesks  Cllbd

Notes  Cuks
For Folow tp s e |

o Folder Lt~ Clrkes,

A Shortcuts k7.

%6 B KPR [

3 5 Weibox - chs| OB Joumal_ Gee

 Deleted 1§ Folder...  Curhsy





Users can take advantage of the Go menu or the integrated keyboard shortcuts for each of the modules of the Navigation pane.
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Key functionality

Several customer-requested improvements have been made to the process of addressing, composing, and sending e-mail messages in Outlook 2003. These features are designed to help all users be more productive with their e-mail.

Streamline e-mail creation

Simplified e-mail creation helps with overall efficiency and productivity. Outlook 2003 now offers a simplified Word Mail user interface (using Microsoft Office Word 2003 as the e-mail editor), which is easier to use, is less confusing, and requires less training. Additional new features that help streamline e-mail creation include expandable distribution lists, improved AutoComplete, Unicode support, and Internet faxing.

Expandable distribution lists

Distribution lists can now be expanded to display the names of the people on the list, making it easy to add or remove a few names before sending the message. This eliminates the need to modify the distribution list or start from scratch when addressing an e-mail message to a distribution list.
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Click the plus sign next to a distribution list to expand it and list all members.
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Members of the distribution list appear after clicking the plus sign.

Improved AutoComplete

AutoComplete now matches on just one letter instead of three, and the AutoComplete list is sorted by the most frequently used e-mail addresses instead of alphabetically. In many cases the user can address e-mail by pressing the first letter in that person’s name. Tablet PC users place their cursor into the address line and point to their most commonly used e-mail addresses, choosing the one they want. Users spend less time searching for the correct e-mail addresses and significantly reduce the required number of keystrokes overall.

Simplified e-mail editor in Word 2003 

The experience of creating a new e-mail message has been vastly simplified. Commands have been consolidated into a single toolbar called E-mail, which is positioned directly above the text of the message. As a result, the number of buttons on the screen has been reduced by more than half, making it easier for users to find what they need and leaving more room for the message.
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The Word e-mail editor has been redesigned with simplicity in mind.

Unicode support

Outlook 2003 supports Unicode for Contacts, Mail, Calendar, Tasks, and Notes. Users can view and edit text within Outlook 2003 in any language and any script that is installed and is supported by the operating system. Unlimited support for Multilingual User Interface enables IT administrators to switch the user interface and Help files to different languages based on the user’s needs.
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Support for Unicode allows Outlook to appear in the user’s native language–in this case a Contact in Hindi.

Internet faxing

With Internet faxing, faxes can be sent and received directly from a desktop computer, eliminating the challenges that can accompany using a fax modem, such as tying up the telephone line, incurring long-distance charges, and having to redial or manually confirm that the fax arrived.

Office 2003 Editions integrate Internet faxing with its programs, including Outlook 2003. Some new faxing features include fax numbers made available in Contacts, a rich preview tool, the ability to calculate the cost of the fax before sending it, cover pages that are editable in Word 2003, and even the ability to sign your name using a Tablet PC.

Internet faxing in the Office 2003 Editions require users to sign up with one of the faxing services that partner with Microsoft Office. (For a list of Microsoft Office fax partners, see Office Online at http://office.microsoft.com.)
Organize and prioritize e-mail

Users are now faced with an increasing volume of incoming e-mail messages. This influx of messages requires more intuitive and efficient organizational tools. 

Quick Flags

Studies of customers using Outlook found that most people do one of three things with nearly every e-mail message:

1. Respond to it immediately. 

2. Delete or file it immediately.

3. Save the message in some way as to indicate that a follow-up action is required. Because they lack the time or information that is required to take action right away, they decide to follow up on it later.

There are almost as many approaches to the third option as there are users—mark the message as unread, move it to an e-mail folder named To Do, make a task out of it, delete or file all messages that don’t require a response, and so on. While these strategies may work for a particular individual, they are makeshift responses to an ever-increasing volume of e-mail for which earlier versions of Outlook were not designed.

Outlook 2003 offers Quick Flags as a simple solution to this problem. Activated by a single click, Quick Flags provide a means for users to “flag” messages for follow-up action or later reference.

To assign a Quick Flag to a particular message, a user clicks the flag icon on an e-mail message from any folder in Outlook 2003. Each marked or "flagged" message has one of several colored flags (as chosen by the user) visible next to it so that it is easy to find at-a-glance. Users can choose colors that work best for them, such as red for high priority or blue for personal to-do items.

Items marked with a Quick Flag are automatically stored in the For Follow Up folder, which becomes an automated, virtual to-do list in Outlook. The For Follow Up folder shows all flagged items at-a-glance and enables users to work with and organize items by color. For more information about the For Follow Up folder, see the following section.
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Click the gray flag icon to Quick Flag an e-mail item. Click the icon again to mark it complete. The Insert key can also be used to add or complete a Quick Flag. 
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Users can also select one of six different colors from a right-click menu to categorize their follow-up items easily.

Using the For Follow Up folder

To make finding messages even easier, a special Search Folder called For Follow Up exists. This folder always contains an up-to-date list of all messages that have been marked with a Quick Flag for every folder in the Inbox. A user who is ready to take action on these messages can open the For Follow Up folder and find every message that has been marked. When finished with a message, the user single-clicks again to mark it as Complete, and the message is stamped with the date/time it was completed. The For Follow Up folder is a default folder that is located in the Favorite Folders section.
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The For Follow Up folder collects a to-do list of every item that has been Quick Flagged in every folder in a mailbox. By default, it is arranged by Quick Flag color so that users can easily see what goes with what. Also, users can drag a message between groups to reclassify it. For example, to turn a yellow quick flagged item into a red quick flagged item, a user could just drag the message from the yellow group to the red group.
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Quick Flagged messages can also be arranged by date.
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Outlook records the date and time the task was completed, and displays it in the InfoBar on the top of the message.

Search Folders

Search Folders help users spend less time filing and finding e-mail messages. Search Folders are actually live search results that look like traditional e-mail folders but differ because they do not store e-mail messages. They are virtual folders that contain views of all e-mail items matching specific search criteria. Search Folders display the results of previously defined search queries, but all e-mail messages remain in their original Outlook folder. By using Search Folders, users can easily group and browse through all items relating to a subject, person, task, or other criteria, without physically moving messages or folders.
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Search Folders work just like folders, except that they can reference e-mail messages from multiple folders.
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Users can drag frequently used folders or Search Folders to the Favorite Folders section of the Mail pane to keep them handy. This reduces the need to navigate through a deep hierarchy.

Using default Search Folders

Three Search Folders are created for users by default, so even beginners can take advantage of this new tool:

Unread Mail. All unread e-mail messages, regardless of their folder location, are shown in the Unread Mail search folder.

For Follow Up. This folder provides a virtual to-do list of all messages that have a Quick Flag applied.

Large Mail. This folder assists with mailbox cleanup by showing the largest e‑mail messages from the entire Inbox.

Creating customized Search Folders

After using the default Search Folders, intermediate users will want to create their own folders for customized searches. To make this as easy as possible, Outlook 2003 offers a template gallery that includes 13 ready-made templates for common Search Folders. These templates make it possible to create a wide range of Search Folders with just a few clicks. The following are some key Search Folders that can be created from templates:

· Important Mail. This provides a central location for all e-mail messages that are marked as having high importance.

· Mail from and to a specific person. This helps users stay current with customer and personal relationships. For example, it can help answer questions such as “Do I owe Janet a message?” or “Where is that e-mail conversation I had with Marc?”

· Old Mail. This is helpful in locating old messages for archiving.
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To create a new Search Folder with the template gallery, from the File menu, click New and select Search Folder. 

Users can also create a custom Search Folder by choosing the last template, “Create a custom Search Folder.” Under Customize Search Folder, users click Choose and type a name for their customized Search Folder. After selecting the search criteria for the customized folder, users can select and search the folders they want to browse. 
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Users can create Search Folders by modifying existing templates.

Save searches from Find or Advanced Find as Search Folders

By using Find or Advanced Find, users can save any search that was created with Outlook 2003 as a Search Folder or use any of the templates that are provided to create a customized Search Folder. In both cases, the user can specify not only the search criteria but also which folders Outlook 2003 searches to create the Search Folder. Search Folders can be easily customized at any time. Users can even perform another search within the contents of a Search Folder to refine their results further.
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Users can also save search results from Find or Advanced Find as a Search Folder. To save the results of Find as a Search Folder, on the Find bar, click Options and select Save as Search Folder. To save the results of Advanced Find as a Search Folder, from the File menu in the Advanced Find dialog box, click Save as Search Folder.

New Mail desktop alert

Outlook 2003 offers a new desktop alert to replace the previous new e-mail message alert. The New Mail Desktop Alert fades in subtly with the name, subject, and a short text preview. It appears just long enough that users can immediately see whether the new message is urgent, should be marked for follow-up, or can be safely ignored without interrupting the current task. The alert contains quick buttons to open, flag, or delete the e-mail message, and if ignored, fades out just as subtly as it appeared. This is completely configurable by the user.

[image: image32.png]T4 Contoso.Word - Microsoft Word 2003

Ele Edt Vew Iwet Fomat ook Table Window Hep Type aquestion for help 1+ | X

RN=A" RERENE NN EEY:- e AN N | 31 75% - @ | JiRead TaskPane Ext

A4 beader  + TmeshewRoman - 12 - | B Z U |

7 covimoss
G 0357 o e Srce 1921

CONFIDENTIAL
‘Quarterly Salss Report

Executive Summary

This quartr maked the launch of o new dugs which resulted n higher han antdpated
Sales inthe fist s wesks ofthe quarter, Dvera, sales were over 15% higher quarter over
Quarter, and aven more impressively, were more than 1816 hgher Bis quarter han he same

quarsr st year

Situational Analysis

Kirk Gregersen v x
Contoso Sales Plan

Jeune,

The produds were met with surpisng enthusiasm and were covered broadly i pintanfl ¥ K Here 1 the Contoso Seles Flan you requssted,

This quarter Contoso Pharmaseuials sussessfully launched o new products n nao

broadeast news. Gne products targeted at theumtoid athits treatmert, and the ol
- stimulant s smant fo startion defiat disorder.

“«o g

wam
Sec 1 14  At27 né Coll Ox





The New Mail Desktop Alert appears while users are working in programs other than Outlook.

Bigger Personal Folders File

The improved Personal Folders File (*.pst) stores up to 20 GB of data by default (administrators can specify a larger folder if they choose) and supports multilingual Unicode data. The new Outlook Personal Folders File will not work with earlier versions of Outlook. Outlook 2003 still supports Outlook 97 through Outlook 2002 Personal Folders Files, which are limited to about 2 GB of data. These improvements are also leveraged for the Offline Folders Files (*.ost).
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When creating a new Personal Folders file, the new format Microsoft Outlook Personal Folders File is used by default. On the File menu, use the New Outlook Data File entry to create new Microsoft Outlook Personal Folders and also to create backward-compatible Microsoft Outlook 97 through Outlook 2002 Personal Folders Files, so users who have older versions of Outlook on a home computer can still create compatible personal folders.

Prevent unwanted e-mail

Unfortunately, in addition to an increasing volume of e-mail, users are being inundated with junk e-mail. These e-mail messages can be bothersome and distracting, but they can also have a more serious impact by taking up valuable storage space.

Block external content

By default, Outlook 2003 helps protect the privacy of its users and provides them with more control over the information in their Inbox. This protection is enabled through a new feature called Block External Content. 

HTML-formatted messages often contain pictures that are not included in the actual e-mail message but are instead downloaded from a Web server when the e-mail message is opened. Junk e-mail senders have used this capability to their advantage by including something called a “Web beacon” in these messages. A Web beacon notifies the Web server when a user reads the junk message, validating the e-mail address. If an e-mail message tries to connect automatically to a Web server on the Internet, Outlook 2003 blocks that connection until the user decides to view the content, which takes only one click. The user can turn off this feature.

Giving users control over external content has several advantages:

· Automatic connections to arbitrary Web servers on the Internet are no longer allowed, cutting off the unwanted flow of information to e-mail solicitors.

· Because pictures are not shown unless requested, offensive messages can be deleted without the user being subjected to its images.

· Users on a low bandwidth connection can choose whether an image is valuable enough to warrant the time and bandwidth to download it.

It is important to note that Outlook 2003 retains all its rich functionality for viewing and sharing pictures. Outlook 2003 will block all pictures by default if they are sent with the message and not on a Web server. 

· Content creators who want to send richly formatted HTML e-mail to their customers can still do so by including the pictures in the body of the e-mail message. 

· Pictures that are inserted into e-mail by using Outlook or Outlook Express already use the MIME Encapsulation of Aggregate HTML documents (MHTML) standard by default and include the pictures in the message, so they are not affected.

· Any e-mail that includes references to images or content on the Intranet or on Trusted sites (defined by the Intranet and Trusted zones of Internet Explorer) will not be affected.

· Any e-mail messages that were sent from someone on a defined list of trusted senders will not be affected. Users can easily add e-mail addresses to this list (which includes the corporate directory and the user's local contact folder by default).
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Mail messages that attempt to download content from the Internet are not allowed to make the connection without the user’s permission. The colored InfoBar strip at the top of the message lets users know that the content was blocked.
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Clicking the InfoBar brings up a context-sensitive menu. Users can turn on images for a specific message using this menu. Users can also add individual e-mail addresses to a Trusted Senders list, to disable content blocking for all mail from that address.

Working with Outlook 2003 Rules and Alerts improvements

The experience for creating, viewing, and changing new rules to handle e-mail messages has been streamlined. 

Rule actions can be viewed graphically and modified quickly. In addition, users can associate alerts with their rules to stay abreast of current information.

To view the new Rules and Alerts functionality, do one of the following:

· Go to the Tools menu and click Rules and Alerts, or

· In the Rules and Alerts dialog box, click New Rule, or

· Right-click any e-mail message and click Create Rule
Filter Junk e-mail

Outlook 2003 includes functionality that has been designed to help eliminate much of the unwanted e-mail that users get every day. These features give users control over the kinds of messages they receive and from whom.

Features

Outlook 2003 provides features that are designed to work together to help protect users from unsolicited e-mail messages:

· Trusted Senders list. If an e-mail message is mistakenly marked as junk by the filter, the user can add the sender of that message to the Trusted Senders list. E-mail addresses and domain names on the Trusted Senders list are never treated as junk e-mail, regardless of the content of the message. Contacts are automatically trusted by default, and mail from them will never be treated as junk. With Microsoft Exchange Server, mail from within the organization will never be treated as junk, regardless of the content of the message. Users can configure Outlook 2003 to accept mail only from the Trusted Senders list, giving users total control over which messages reach their Inbox.

· Junk Senders list. E-mail from a certain e-mail address or domain name can easily be blocked by adding the sender to the Junk Senders list. Mail from people or domain names on this list are always treated as junk, regardless of the content of the message.

· Junk e-mail filter. Outlook 2003 uses state-of-the-art technology developed by Microsoft Research to evaluate whether a message should be treated as junk e-mail based on several factors, such as the time it was sent and the content of the message. The filter does not single out any particular sender or type of e-mail; it is based on the content of the message in general and uses advanced analysis of the structure of the message to determine how likely it is to be thought of by the user as junk.

By default, this filter is set to a low setting which is designed to catch the most obvious junk e-mail. Any message that is caught by the filter is moved to a special Junk E-mail folder, where a user can retrieve it at a later time. The user can choose to make the filter more aggressive (perhaps mistakenly catching more legitimate messages) or even set Outlook 2003 to permanently delete junk e-mail as it arrives.

· AutoUpdate. Microsoft is committed to providing periodic updates of the Junk E-mail filter so that it continues to be effective. 

· Trusted Recipients list. A mailing list can also be added to the user’s Trusted Recipients list. Any e-mail that is sent to e-mail addresses or domain names on this list will not be treated as junk, regardless of the content of the message.

The Junk E-mail filter is turned on by default. The first time Outlook 2003 moves an e-mail to the Junk E-mail folder, it will notify the user by way of a dialog box. 

How to customize

Users can customize junk e-mail settings to meet their needs. To change junk e-mail settings, select Options from the Tools menu and click Junk E-mail. To add people to the Trusted Senders, Trusted Recipients, or Junk Senders lists, right-click the message and click Junk E-mail, or click Junk E-mail on the Actions menu. For versions of Microsoft Exchange Server without Cached Exchange Mode (see Cached Exchange Mode), junk e-mail filtering must be installed and configured on the computer running Microsoft Exchange Server.
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The first time Outlook 2003 downloads an e-mail message that appears to be junk e-mail, a dialog box appears to inform the user. By default, this dialog box comes up each time a suspected e-mail message is downloaded—however, it can be easily turned off by clicking “Please do not show me this dialog again.”
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Suspect messages are moved to the Junk E-mail folder by default.
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The Junk E-mail Options can be opened from the Tools menu, under Options-> Junk E-mail. Users can choose the appropriate level of protection, ranging from no protection to trusted lists only. Users can also choose to delete mail permanently instead of moving it to the Junk E-mail folder.

Enable worker mobility and productivity

Outlook 2003 provides many technical advances that help users connect to information and use it more effectively without having to worry about issues such as network performance.

Cached Exchange Mode

The new Cached Exchange Mode in Outlook 2003 delivers a reliable and responsive user experience, independent of network performance, by loading all necessary data up-front rather than while e-mail is read. Cached Exchange Mode insulates the user from network issues, ensuring that the user is able to remain productive at all times. As such, the feature provides advantages for IT directors, reducing support calls, making server site consolidation possible, and enabling a new set of mobile scenarios. On a new installation of Outlook 2003, Cached Exchange Mode is on by default. With an upgrade, the user can enable Cached Exchange Mode.

For several releases, Outlook 2003 has had the ability to synchronize data between the Exchange Server and its local store. Users now can use Send/Receive groups to synchronize their data. Office 2003 Editions offer the ability to use the new Cached Exchange mode in Outlook 2003 to synchronize data continuously. 

When working with Exchange Server 2003, synchronization is more efficient and robust because the server and client communicate in a way designed to reduce the amount of data that is transferred between the client and server during synchronization. These improvements are especially important for mobile scenarios in which the connection from Outlook to the Exchange Server is over a network that has limited bandwidth and variable latency. This efficiency results in cost savings on “pay-by-the-byte” networks, and generally reduces the amount of time that is required to complete any synchronization, making the benefits automatic. 

Intelligent Connectivity

The Intelligent Connectivity feature introduces network “awareness” to Outlook 2003, so that the program is more responsive over low-speed or unreliable network connections, or when a user is moving from one wireless network connection to another. This enables Outlook 2003 to remain usable, and when combined with the Cached Exchange Mode, the network hides reliability from the user almost entirely—meaning there are no connection-error messages.

The synchronization modes of Cached Exchange Mode include Download Headers and Full Items, Download Full Items, Download Headers, or On Slow Connections Download Headers Only (the default mode for a slow connection, which can be overridden). Users can change the Cached Exchange Mode connection setting by selecting Cached Exchange Mode from the File menu, and then selecting one of the following synchronization modes: 

Download headers and then full items. This mode downloads all headers and complete items, including attachments. Users can click a header, and the full item is downloaded immediately.

Download full items. This mode downloads the header, body, and any attachments simultaneously. This mode is effective with a network connection or a continuous dial-up connection.

Download headers. This mode downloads headers only. The full item including attachments is available when the user previews or opens the item. This mode is useful to keep the amount of data transferred between Outlook and the computer running Microsoft Exchange as small as possible.

On slow connections download headers only. This is the default setting for a slow connection. The body, including any attachments, is downloaded only at the user's request or as needed for synchronization or auto-archiving. The Offline Address Book is not downloaded. This mode is effective when using dial-up connections or cellular wireless with General Packet Radio Service (GPRS) connections. 
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The Cached Exchange Mode menu shows the options that are available when connecting to slow or unreliable networks.

Connectivity to Exchange through HTTP

Gaining access to a Microsoft Exchange Server by using Outlook has traditionally required direct access to the server, either through a local area network (LAN) connection or by connecting remotely through a virtual private network (VPN) connection. With Outlook 2003 and Exchange Server 2003 running on Microsoft Windows Server 2003, users can open their Exchange Server computer directly by way of HTTP over an Internet connection. By using Outlook 2003, if a user can browse the Web, the user can open his or her Exchange mailbox.

After the feature is operational, Outlook 2003 automatically connects by way of HTTP when a direct connection to the Exchange Server is unavailable, eliminating the need to have corporate VPN servers set up for e-mail access.
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Office administrators can now easily configure Outlook 2003 to communicate with an Exchange Server over the Internet.

Notification Area icon

Most people keep their e-mail program running all the time. The new Notification Area icon in Outlook 2003 makes it possible for users to stay on top of their e-mail messages even when working in another program. The Notification Area icon shows the status of Outlook 2003, even when the program is hidden, minimized, or in the background. 

The Notification Area icon displays different types of information in new ways:

· Informational messages. Outlook 2003 provides alert and reminder information to the user in a less intrusive manner. Notification “pop-up balloons” now notify the user of status changes and other information in a subtle manner, allowing the user to continue working. In previous versions of Outlook, message boxes indicating status would appear and block the screen. With Outlook 2003, users can read the message if they choose, but do not have to respond. Users can also choose to opt out of groups of messages that they do not want to receive in the future. 

Note: Opting out of receiving messages does not affect any error logs that might be created.

· Synchronization status. This icon shows when Outlook 2003 is downloading and sending e-mail. This is useful when a user wants to work in another program until Outlook 2003 has finished sending or receiving e-mail.

· Network problems. If Outlook 2003 has a problem with the network or with the e-mail server, it notifies the user by changing to a “trouble” icon. In most cases, configuration data is still available, but no new messages are received until the trouble is resolved. Users can cancel the network operation by clicking the icon and selecting Cancel Request.
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The Notification Area icon can show informational messages in pop-up balloons. The Notification Area icon is always available in the notification area of the Windows taskbar. Click or right-click the icon to open the menu. Then, double-click the icon to open Outlook (even when Outlook is hidden).

Kerberos authentication

In addition to the Windows NT® LAN Manager (NTLM) protocol, Outlook 2003 supports Kerberos authentication when running Exchange Server 2003, giving corporations more options for meeting their authentication needs.

More effective contact management

Users can now take advantage of enhancements to the Address Book, including an updated interface and the option to insert a picture. 

Improved Address Book interface

The Select Names dialog box in Outlook has been redesigned to help users view more information on the screen at one time. The dialog boxes are completely resizable based on user preferences, making it possible to take advantage of today’s larger monitors. And, common commands have been made more prominent in the user interface.
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The new Address Book Chooser is resizable and has been redesigned to be more intuitive.

Contact picture

The ability to add a picture to Contacts is one of the most frequently requested features from customers. With Outlook 2003, pictures can be added directly to the contact information, giving users the ability to associate a face with the name and other available information.
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The contact with a picture added.

Bring relevant information to people’s fingertips

The Office 2003 Editions have created two new panes to bring relevant information to its users: the Document Recovery pane and the Research task pane. The Document Recovery pane safeguards users against the loss of data, while the Research task pane allows users to browse the Web for information within the program that they are working from.

Document Recovery pane

The Document Recovery pane in Microsoft Office PowerPoint® 2003, Word 2003, and Microsoft Office Excel 2003 helps prevent the loss of work when one of the programs encounters a problem and stops responding. The files that are listed in the Document Recovery pane can be opened, their repairs can be viewed, the files themselves can be compared, and one or all of the files can be saved. The listed files are clearly labeled as “original” and “recovered.” The Document Recovery pane allows users to connect with the temporarily lost information quickly and easily.

Research task pane

Each Microsoft Office program and Microsoft Internet Explorer (through an Office add-on) now includes a Research task pane that allows users to search for information through the Web or a corporate data source from directly within the program. Now users can access corporate data and work with their research information right alongside their reports, charts, and other documents. 

Search results can be pulled into the document without switching programs, and through the use of Smart Tags, the data source can provide a variety of actions beyond the typical copy-and-paste of HTML that a Web search would accomplish. For example, a search against a corporate data source could provide the option to refine the search with additional parameters, insert the results as structured XML data into Excel, or present the information as a linked, refreshable XML document fragment from a content database. 
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Through the Research Library task pane, users can research the Web or corporate resources right alongside their documents.

Research task pane vs. ordinary Web searches

A Web search searches publicly available information and returns formatted text or, occasionally, documents as the results. The results are viewable in a browser only, not in any Office programs.

The Research task pane searches the Web as well, but it also searches numerous other sources that are not available to Web searches, including the following sources:

· Subscription services such as Factiva, e-library, or Gale company profiles (a paid subscription is required for access)

· Microsoft services such as dictionaries, thesauri, or the Microsoft Encarta® encyclopedia

· Translation services through Microsoft partners

· SharePoint Portal Server computers inside a company's firewall

· Corporate databases inside a company’s firewall that have been provided with a Research Library front-end (either on the server or on the client), such as customer databases, sales data, product catalogues, or support databases

Most powerfully, the Research task pane is not limited to returning only formatted text as a result. It can return XML data from Web services or databases. Using Smart Tags linked to the data types returned, a service can provide the user with options to insert the data into programs or take special actions. For example, if sales data is returned from a search in Excel, the service can provide an action to insert the data as a refreshable Web query or to create a PivotTable® or PivotChart®. Likewise, the same service might offer different actions in Word 2003 or PowerPoint 2003. 

An SDK is available to developers to help them build their own research services or to put a research front-end on an existing data source. Many partner vendors are already preparing research front-ends for their server products and services.

Research Library closes the XML data loop by letting end users access all the data inside or outside an organization and reuse it within Office programs.

Research task pane tools

The Research task pane also includes basic resources such as a thesaurus and dictionaries in multiple languages (available even offline), as well as automated translation, and an encyclopedia on the Internet. If the user or corporation has signed up with third-party data service partners such as Factiva, eLibrary, and others, these are also searched, and the results are presented in the Research Library. 

Looking up information by using the Research task pane is simple: hold the Alt key and click on a word in your document. Users can also right-click or use the menu or toolbar to open the Research task pane. It will appear with results even if it was not open when the search was initiated.

In Microsoft Outlook 2003, the Research task pane makes it easier to read foreign-language e-mail messages because a single click will provide a translation of a word, or the entire e-mail message, to the user’s native language. This is especially useful in multinational corporations where many users do not natively speak the predominant language.
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The Research Library task pane provides a variety of tools and resources. 

Flexible information management technologies

Ink integration in Office 2003 Editions programs

In Office XP, Tablet PC users were able to download the Microsoft Office XP for Tablet PC (Tablet Pack) add-in to create Ink e-mail messages and to handwrite emails in Outlook. In Office 2003 Editions, Ink is integrated directly into the programs, allowing Ink users to use more functions and use Ink more effectively for annotating and drawing within their documents. Support for Ink has also been improved throughout the Office suite.

The following are some of the benefits of tighter Ink integration with Office 2003 Editions:

· Handwriting within Office 2003 Editions programs. Users can treat their Outlook emails, Word documents, Excel worksheets, and PowerPoint slides as a piece of paper, making notes directly on top of the document or in the margins, sketching out ideas and saving them for later, without having to worry about supplemental software to accomplish the notation. 

· Two Ink toolbars. An Ink toolbar is available for drawing and writing, and another for annotations. Each provides a set of ballpoint pens, felt tip pens, and highlighters, enabling users to change the color and width. 

· Familiar interface. Other Ink features in the Office 2003 Editions use the same familiar interface that is found in the previous Tablet Pack. 
· Copy and paste. Users can copy and paste Ink objects between programs.

[image: image46.png]8] New - Microsoft Outlook =l

actons

Edt Vew Go

SiNew + iy

Tools

Help

Reply o Al

Type a question for help

Favorte Folders

[ Inbox (22)

2 uveadiiar

(3 For Follow Up [52]
[ sent tems

Al il Foders

2 2 Maibox -Jeune i
@) Deleted tems
) brafts [17)
25 Inbow (22)
4 Marketing
3 Budget
3 saes
Caew (1)
3 Proposals
 Cortent

E Calendar
Contacts
ﬂ“ Tasks
l A l "I

| [, Type & contact to find

Laok for:

- SearchIn~.

RE: Contoso propossl

5 Frank zhang

i Frank zhang
Froject meeting

1S3

e repeet /
Fhis afternom .
TRk

From: Ed Meadaws

Sent: Monday, Septermber 23, 2003 3:43 FM
To: Jeune Ji

Ce: Gibert, Guy

Subject: Report

Importance: High

< i

o i omins~ X
New
vty e aont ||| re: Report
[ R Guy Gllbert
= Jeune 3i To: Jeune i
1 Jeune Ji 4:53PM
re: Report N
3 s Flease Send At
A s e

3 ttems |

Al fokdrs areup o date| [0 Connected ~





Support for Ink is enhanced throughout the Office 2003 Editions. Here, a user adds handwritten notes to an Outlook e-mail message.

Office document imaging

Document imaging in Outlook 2003 enables users to scan paper documents and convert them to digital images that can be stored on a hard disk, network server, CD, or DVD. Digital images can be saved in TIFF or MDI file formats. 

Two components make up Document Imaging—the Scan component and the Imaging component. On the Office Start menu, these appear as Microsoft Office Document Scanning and Microsoft Office Document Imaging. 

· Office document scanning. Use the Scan component to make scanned documents available on the user's computer by using any installed scanner. The presets that control the scanner are optimized for specific purposes. Black and White produces the best results when scanning text; Color produces the best results when scanning pictures or artwork.

· Optical character recognition. Optical Character Recognition (OCR) translates images of text into actual text character. By using OCR, users can manipulate text, search, or copy text to another program. For best results, use the Black and White preset for OCR.

· Develop image-based custom programs. Users can insert images from the scanner into a Word document by using Office Document Scanning or by using the software that came with the scanner. 

· Annotate images. Users can annotate images easily for document sharing.

· Office Document Image Writer. By using the Document Image Writer, users can view scanned documents on-screen, rearrange multiple-page documents with ease, select and work with OCR text, and annotate or send fax documents.

Edit pictures

Users can change how pictures look by adjusting these settings and tools: brightness and contrast, color, crop, rotate and flip, red eye removal, and resize. After editing is complete, users can save the edits to the current file or keep the original file by exporting the changed picture to another file name or to another location.

Share pictures

After editing is complete, users may want to share them with a workgroup. Pictures can be sent in e-mail messages, or users can create a Windows SharePoint Services picture library for a rich collaboration experience. The SharePoint picture library offers simplified administration and role-based permission settings in addition to a unique picture-management model that enables users to download picture versions of any size or resolution, while efficiently storing the original pictures. 

Shared pictures can be compressed to a file size that is the most efficient for the sharing medium. Smaller file sizes appear more quickly on Web pages and take up less disk space. If the user is sharing pictures in e-mail messages, smaller file sizes are sent more quickly.

Summary

With Microsoft Office 2003 Editions, users have new ways to stay organized and manage the details that accompany information overload. New design enhancements to Outlook 2003, including the new Reading task pane, Search Folders, and Quick Flags help users save time and manage information more effectively.

Introduction

Microsoft Office Outlook 2003 offers several new features to its users. These new features are individually described within the following sections.

Reading task pane

Using the Reading task pane reduces eyestrain and makes time spent reading e-mail messages more efficient by showing more of the message on the screen. The Reading task pane reduces scrolling and minimizes the need to open and manage many separate windows for different e-mail messages.
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More of the message is visible with the Reading task pane.

How to use the Reading task pane

To change the Reading task pane options:

1. On the Tools menu, click Options, 

2. Click the Other tab.

3. Click Reading Pane.

To change the location of the Reading task pane:

4. On the View menu, point to Reading Pane. 

5. Click Right or Bottom.

To hide the message header:

6. On the View menu, point to Arrange By, click Custom, and then click Other Settings. 

7. Under Reading Pane, select the Hide header information check box.

Multi-line message view with Smart Dates and grouping

Organizing messages is easier with Outlook 2003. The Multi-line view puts the sender’s name in dark text in the upper-left corner, making it easy to scan down the list for important names. Secondary information is rendered in lighter shades of text to draw the eye toward the more important information. This view also makes messages easier to select with the pen on a Tablet PC.

To use space more efficiently, Smart Dates change the date format on the fly based on how long ago the message was received. For example, an e-mail message that was received today will only display a time: 3:40 p.m. Messages that were received during the current week display a day of the week and time: Wed 1:24 a.m. For e-mail that was received many months ago, the exact time is less important, so Outlook 2003 displays only the date: 1/12/2003. This makes it easier for the user to sort, find, file, and manage e-mail quickly and efficiently.

The new e-mail view automatically applies intelligent groupings to help sort messages. For example, when messages are arranged by date received, Outlook 2003 splits them into simple groups (“Today,” “Yesterday,” “Last Week,” “Last Month,” and so on). When messages are arranged by size, Outlook 2003 again divides messages into user-friendly groups (“Large,” “Small,” “Very Large,” and so on). These groups make it easier to scan through a list of several messages. 

Users can treat these groups as objects, choosing to move, delete, copy, forward, or perform other actions on all items in the group at one time. For example, messages can be grouped by date, and then the user can drag all the messages from “Last Month” to another folder, filing them away with one click. 
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Users can specify the number of lines that display in multi-line view.

How to change multi-line view settings

To change the number of characters displayed before multi-line layout switches to single-line layout:

8. On the View menu, point to Arrange By, and then click Custom. 

9. Click Other Settings. 

10. Under Other Options, select the Use multi-line layout in widths smaller than n characters check box, and type the number you want for n. 

To specify the number of lines that display in multi-line view:

11. On the View menu, point to Arrange By, and then click Custom. 

12. Click Fields. 

13. In the Maximum number of lines in multi-line mode box, select the number you want.
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When users rearrange e-mail messages, Outlook 2003 groups them into logical units.

How to apply intelligent grouping

14. On the View menu, point to Arrange By, and then select the appropriate arrangement. 

15. To customize the arrangement that has been applied, on the View menu, point to Arrange By, click Custom, and then select the appropriate options.

Arrange by conversation

This feature groups messages by message subject or “thread.” The sorting order of items in the “threads” is based on who replied to whom, and the sorting order of the groups is by date. When a new message is received, the entire conversation to which it pertains moves to the top of the message list. By default, only unread and flagged messages appear. Users can see all messages in the conversation by clicking the arrow that appears next to the conversation heading. Messages are indented to show who replied to whom and when the reply was sent.
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Arrange e-mail messages by conversation to sort by subject or thread.

How to arrange by conversation

16. On the View menu, point to Arrange By, and then click Conversation. 

17. To customize the arrangement, on the View menu, point to Arrange By, click Custom, and then select the appropriate options.

Go menu

To move between the different Navigation pane module views quickly, users can use the Go menu or the integrated keyboard shortcuts. The following are keyboard shortcuts:

· Mail

CTRL+1

· Calendar
CTRL+2

· Contacts
CTRL+3

· Tasks

CTRL+4

· Notes

CTRL+5

· Folder List
CTRL+6

· Shortcuts
CTRL+7

· Folder

CTRL+Y

[image: image51.png]Ble Edt Vew

Tools _Actions el
wal i1

@

Ditew - | 4

Colendsr Cikz

Favorie Folders g G
Tesks  Cllbd

Notes  Cuks
For Folow tp s e |

o Folder Lt~ Clrkes,

A Shortcuts k7.

%6 B KPR [

3 5 Weibox - chs| OB Joumal_ Gee

 Deleted 1§ Folder...  Curhsy





Navigate between the different modules by using the Go menu or keyboard shortcuts.

How to navigate using the Go menu

On the Go menu, click the appropriate Navigation pane module or view.

Quick flags

Use this feature to mark messages with a flag for follow-up action or later reference. Flagging a message, meeting request, or contact adds a flag icon to the item. Use the six colored message flags to manage incoming e-mail items by flagging the items for different kinds of follow-up action.

When users add a message flag, the background color of the Flag Status column changes color, making it easy for users to find items in the message list while scrolling. Items to which a message flag is added automatically appear in the For Follow Up Search Folder.
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Use the colored message flags to flag items for different kinds of follow-up action.

How to flag an e-mail message

18. Click the flag icon on an e-mail message to flag it with the default flag. 

19. To flag the message with a different colored flag, or to change the default flag color, right-click the flag icon, and then click the appropriate option.

For Follow Up folder

Any message, meeting request, or contact that has been flagged is visible in the For Follow Up Search Folder. Because it is a Search Folder, the items remain in their original Outlook locations. Items are grouped by the type of follow-up action they require, which 

is indicated by the color of the message flag. Use this folder to group and browse items that are intended for follow-up action or further reference. 
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The For Follow Up Search folder contains a view of all items that have been flagged.

How to view the For Follow Up Search folder

20. Make sure that at least one message, meeting request, or contact has been flagged. 

21. In Mail, in the Favorite Folders area, click For Follow Up.

Search Folders

Search Folders are virtual folders that contain views of all e-mail items matching specific search criteria. Search Folders contain the results of previously defined search queries, but all e-mail items remain in their original Outlook folder. With Search Folders, users can easily group and browse through all items relating to a subject, person, task, or other criteria, without physically moving messages or folders.

Three Search Folders are created for users by default:

· Unread Mail. All unread e-mail items appear in the Unread Mail Search Folder. 

· For Follow Up. Any e-mail message that includes a flag appears in the For Follow Up Search Folder.

· Large Mail. E-mail items that are larger than 100 kilobytes (KB) appear in the Large Mail Search Folder.

These three default Search Folders can be modified or deleted.
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Use Search Folders to group and browse through all items that relate to a subject.

How to create a new Search Folder

22. In Mail, on the File menu, point to New, and then click Search Folder. 

23. Use a predefined Search Folder or click Create a custom Search Folder.

New mail Desktop Alert

In Outlook 2003, the new mail Desktop Alert comes into view with the name, subject, and a short text preview of the new e-mail message. When a Desktop Alert appears, users can set a flag on a message, delete it, or mark it as read—all without opening the Inbox. If the Desktop Alert is ignored, it soon fades from view.

Users can customize the appearance of the Desktop Alerts. The alerts can remain visible for as briefly as three seconds or for as long as 30 seconds. Users can also adjust the transparency to make the alerts more noticeable or to keep them from blocking the view of documents and other items on the desktop. Users can also change where the Desktop Alerts appear by dragging an alert to a more preferable location on the desktop.
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Customize the transparency and duration of the Desktop Alerts.

How to customize Desktop Alerts

24. On the Tools menu, click Options. 

25. On the Preferences tab, click E-Mail Options, click Advanced E-mail Options, and then click Desktop Alert Settings.

Junk e-mail settings

Outlook 2003 includes features that are designed to help prevent much of the unwanted e-mail that arrives every day, and to give the user control over the kinds of messages that can be received. The features include the following options:

· Junk E-mail Filter. The Junk E-mail Filter feature is on by default, and the protection level is set to Low, which is designed to catch the most obvious junk e-mail messages. Any message that Junk E-mail Filter catches is moved to a special Junk E-mail folder, where users can retrieve or review it at a later time. Outlook 2003 can also be set to delete junk e-mail messages permanently.

· Safe Senders List. If an e-mail message is mistakenly marked as junk by the filter, the user can add the sender of that message to the Safe Senders List. E-mail addresses and domain names on the Safe Senders List are never treated as junk e-mail, regardless of the content of the message.

· Blocked Senders. E-mail messages from certain e-mail addresses or domain names can easily be blocked by adding the sender to the Blocked Senders list. Mail from people or domain names on this list are always treated as junk, regardless of the content of the message.

· Safe Recipients List. A mailing list can also be added to the Safe Recipients List. Any e-mail that is sent to e-mail addresses or domain names on this list will not be treated as junk, regardless of the content of the message.

· AutoUpdate. Microsoft is committed to providing periodic updates of the Junk E-mail Filter so that it continues to be effective.
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Use the junk e-mail settings to set the appropriate level of protection, and to add to the Safe Senders, Safe Recipients, and Blocked Senders lists.

How to change the junk e-mail settings

26. On the Tools menu, click Options. 

27. On the Preferences tab, click Junk E-mail. 

28. Click the Options, Safe Senders, Safe Recipients, or Blocked Senders tab to modify the desired settings.

Block external content

Messages that are formatted in HTML often contain images that are not included in the message itself but are instead downloaded from a Web server when the e-mail message is opened. These unannounced connections to Web servers can now be blocked. 

If an e-mail message tries to connect unannounced to a Web server on the Internet, Outlook 2003 blocks that connection until the user decides to view the content. However, e-mail messages from or to e-mail addresses or domain names on the Safe Senders and Safe Recipients Lists are treated as exceptions, and the blocked content will be downloaded. Users can download pictures and other content on a per-message basis by clicking the InfoBar or by right-clicking a blocked image, or can change the settings about automatic picture download for all HTML messages.
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When an e-mail message attempts to download pictures from a Web server, the pictures are blocked. Users can download them on a per-message basis or change the settings.

How to change the Block External Content settings

29. On the Tools menu, click Options, and then click the Security tab. 

30. In the Download Pictures area, click Change Download Settings.

Shared calendar

Users can quickly view another person's calendar, contacts, and tasks from the Navigation pane. After the first time a user gains access to another person's folder, the shared folder is added to the Navigation pane. The next time the user wants to view the other person's folder, the user can select it in the Navigation pane. Likewise, users can share their own calendar with anyone or with only a specified group. In either case, the details of any item that is marked Private are not displayed to other people.
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Users can specify if they want to share their calendars.

How to share a calendar

In Calendar, click Share My Calendar.

How to view another person’s shared calendar

31. In Calendar, click Open a Shared Calendar.

32. To select another person's name from the address book, click Name or type the name in the Name box. The new calendar will appear to the side of any calendar already in the view.

Contact picture

With Outlook 2003, pictures can be added directly into a contact, which means that users can associate a face with the name and other information in the contact.

[image: image59.png]m P onta

Pl Edt Vew Inet Fomat ook | ctions | Help

dseveandcose G4 0 | ¥ 2] -

Generd | Detals | Aciites | Corficat

it te -
ot GoupProgamtensel | o tessog to Cortot

Conpany: adventure Works | 3 ew Meeting Reauestto Contact
Fioas e, 3t

New Agpointment with Contact
Phane numbers

4 Hew Task for Contact

[posness..)[+) msssouce New Sournl i for Contact
r—

[omesree 7] Calcoman
E] Call Using NetMesting

Addresses

@
v

— ~| -
]

] This s the maing Explore WebPags  Cukshit+

Folow L. Cieshiftc

addPicture

Forward as yCard

Forward Culer





When a picture is added to a contact, a name is associated with a face.

How to add a picture to a contact

33. In Contacts, create or open a contact. 

34. On the Actions menu, click Add Picture.

Cached Exchange Mode

In Cached Exchange Mode, a copy of a mailbox is stored on the computer, and the mail server updates the data frequently. If the user is working offline, whether by choice or as a result of a connection problem, the data is still available instantly.
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Cached Exchange Mode stores a copy of the user's mailbox for offline availability.

How to turn Cached Exchange Mode on or off

35. On the Tools menu, click E-Mail Accounts. 

36. Click View or change existing e-mail accounts, and then click Next. 

37. In the Outlook processes e-mail for these accounts in the following order list, click Microsoft Exchange Server, and then click Change. 

38. Under Microsoft Exchange Server, select or clear the Use Cached Exchange Mode check box.

Remote Procedure Calls (RPC) over Hypertext Transport Protocols (HTTP)

With Outlook 2003 and Microsoft Exchange Server 2003 running on Microsoft Windows Server 2003, users can gain access to the Exchange Server-based computer directly by way of HTTP over an Internet connection. With Outlook 2003, if users can browse the Web, they can use the Exchange mailbox.

Outlook 2003 automatically connects through HTTP when a direct connection to the Exchange Server-based computer is unavailable, eliminating the need to have corporate VPN servers set up for e-mail access.
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Office administrators can configure Outlook 2003 to communicate with an Exchange Server over the Internet.

How to connect to the Exchange Server by using HTTP

39. On the Tools menu, click E-mail accounts, and then select View or change existing e-mail accounts.

40. Click Next.

41. Select the Microsoft Exchange e-mail account, and then click Change. 

42. Click More Settings, and then click the Connection tab. 

43. Select the connection you use when working offline.

Internet faxing

Outlook 2003 integrates Internet faxing. This integration allows the users to send faxes by using features that a typical fax machine does not offer. For example, users can use the fax numbers in Contacts, use the preview tool to view a fax before sending it, calculate the cost of the fax before sending it, add cover pages that are fully editable in Word 2003, and even sign their names on their fax if they use a Tablet PC. Users can not only send faxes with Outlook 2003 but can also receive faxes in their Outlook Inboxes.
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With Internet faxing, users save on long-distance phone bills and keep phone lines free.

How to send a fax

On the File menu, point to New, and then click Internet Fax. An e-mail message opens in Outlook 2003 with the document attached as a .TIF (image) file, or a file can be attached to the message.

As this section demonstrates, Outlook 2003 is rich in features and easy to use. Users who require assistance with Outlook 2003 can get online help and services for Office 2003 Editions, as described in the next section.

Help and Training Online

Microsoft Office 2003 Editions offer new and improved integration with Microsoft Office Online Web services. More powerful, better integrated, and with an improved online interface, these services are seamlessly available from within Office 2003 programs. The Web site, also available through a browser at www.microsoft.com/office, offers a resource page for each Office 2003 Editions program. The resources pages have assistance, columns, training, and templates.

Help

The Help system of Office 2003 Editions has been extended beyond individual workstations. If a user is connected to the Internet when choosing a Help topic or entering a word in the Ask-A-Question box, the Help system displays not only the Help information from the local system, but also brings to the Help window information from the Microsoft Web site (www.microsoft.com). This provides the most current information on the topic that the user needs help with, in addition to links to other resources.

Assistance

The Assistance Web page provides up-to-date information with How To articles, conceptual topics, columns, and helpful tips for common tasks. Users can find answers to common questions, read articles on features in Office 2003 Editions, look for specific help in newsgroups, or suggest a topic for a future article.

Office Online Training

The Training site offers Web-based interactive training courses and self-paced exercises. Users can develop deeper knowledge of tasks and application features, such as creating an outline in Microsoft Office Word 2003 or using motion paths in Microsoft Office PowerPoint® 2003 slides. Courses include practice sessions where users can give things a try in the actual program, and short tests to assess comprehension. Courses cover a variety of topics, and are available for any Office 2003 Editions program.
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Use Office Online to find training opportunities for Office programs.

Downloads

On the Downloads site (formerly known as Office Update), users can check for free updates that improve the stability and security of Office 2003 Editions. On the Downloads home page, users can click Check for Updates to start the automatic detection tool, which scans the computer and then returns a list of new downloads that are available and compatible with the user's version of Office. In addition to security and performance updates, viewers, converters, add-ins, stationery, and other useful downloads are also available. The most popular downloads are listed in the Popular Office Downloads section.






To move quickly between Navigation pane modules, use the keyboard shortcuts documented on the Go menu:


Mail	CTRL+1


Calendar	CTRL+2


Contacts	CTRL+3


Tasks	CTRL+4


Notes	CTRL+5





































